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Creating Accessible Web Pages in the CMS 

Adapted from WebAIM.org 
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What is Web Accessibility? 

In order for web content to be considered accessible, all web users, regardless of physical or developmental 
abilities or impairments must be able to access the information presented. At Brandeis, we serve a diverse 

audience and our web visitors use a variety of technologies to navigate our online content. The following best 
practices are provided to help you maximize the accessibility of your Web pages in the CMS.  

*Please note: Accessibility best practices apply to all web content you create in the CMS, as well as any
documents you upload or link to on your site (MSWord, PDF, etc.). For more information check out our online how-

to guides or request further training.

Page Structure 

Headings and Subheadings 

Headings and subheadings organize your content and are important for usability and accessibility. People with 
limited or no vision depend on screen reading software to read aloud the text that appears on the screen. Using 
headings properly provides a hierarchy of content which allows all users to navigate more efficiently.  Proper 
heading structure provides screen reader and other assistive technology users an organized framework. 

Adding headings in the CMS 

Pre-formatted headings are available in the CMS in the Format dropdown of the WYSIWYG editor. 

Figure 1: The CMS WYSIWYG editor

Using headings correctly 

Bold formatting vs. Pre-formatted Headings 

Changes made with Font styling will provide visual structure for some of your users, however, the document 
structure needed for navigation by assistive technology users will be missing. If you bold paragraph text to 
create the look of a heading, a screen reader will still read it as paragraph text. This is not helpful for someone 

using a screen reader. Instead, use a heading style from the Format dropdown in the CMS.  

Conversely, do not use a heading style to make text big and bold if it isn’t really a heading. The screen reader 
will read it as a heading and not properly communicate the emphasis you intended.  

https://www.brandeis.edu/communications/digital/accessibility/how-to-guides.html
https://www.brandeis.edu/communications/digital/accessibility/how-to-guides.html
https://www.brandeis.edu/communications/digital/accessibility/training.html
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Nesting and Order 

Pages should be structured in a hierarchical manner: 

• Lower-degree headings should be contained within headings of the next highest degree. One should not
skip heading levels, such as using a Heading 4 directly below a Heading 2.

• Have one and only one H1 heading. It should encompass the topic of the entire page. On a Brandeis
page, this is your site name.

Nest all subsequent headings numerically: H2 follows H1, H3 follows H2 and so forth. You can use a level more 

than once, but do not skip a level. 

Heading 1 
Heading 1 is your Site Name on Brandeis pages. Do not use Heading 1 style in your main content area in the 
CMS.  

Heading 2 
Heading 2 is the title of your page. Do not use Heading 2 style in your main content area in the CMS. 

Heading 3 
Heading 3 style can be used in your main content area. It should be the first heading style you use on any CMS 

page. 

Heading 4 
Heading 4 style can be used in your main content area. It should be nested below Heading 3. 

Heading 5 
Heading 5 style can be used in your main content area. It should be nested below Heading 4. 

Heading 6 
Heading 6 can be used in your main content area. It should be nested below Heading 5. 

Data Tables 

The associations of information within data tables can be difficult to convey with a screen reader. You can help 
by: 

§ Always using a header row at the top of your table.
§ Making sure the header cells are accurately explaining the data directly below (columns) or to the right 

(rows).

§ Not using the table for notes or extra information that is not directly related to all data in the associated 
row or column. Notes may be provided above or below the table. 

Links 

Hyperlinks can bring users to new pages, other sections of the same page, play videos, download files, or launch 

other software on the user’s computer. It’s important that a user knows what is going to happen when a hyperlink 
is activated (via a click or a keystroke). 
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You may be tempted to use the pervasive “click here” hyperlink. When you fill your page with “click heres,” a 
sighted user has to reread the surrounding text to remember which link is which.  

In the same scenario for a user of a screen reader, she can use a Hotkey to read out a list of all links on the 
page. This list would sound like this: “click here, click here, click here, click here….” 

It is more helpful to: 

• Explain where the link will take you, or

• Describe what action will occur when the link is activated in unique, descriptive language

For example: 

Figure 2: Examples of helpful hyperlinks 

Quick Tips for Linking 

• Are your hyperlinks unique and descriptive?

• Do your link descriptions make sense to the reader out of context? (Imagine all of your links read out
loud as a list. Can you tell which is which?)

The Hyperlink Editing Tool in the CMS 

Figure 3: Pop-up window for inserting and editing hyperlinks in the CMS
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Importance of Color Contrast 

People with color blindness often have difficulty distinguishing certain colors, such as red and green or blue and 
yellow. Almost 5% of the population and 8% of men have some form of colorblindness. When color combinations 

(such as red text on a green background) are of insufficient contrast, the words can actually disappear to a 
person with colorblindness. You can help prevent this by selecting strong, contrasting color combinations and by 
labeling things that are otherwise distinguished only by color on a page (think charts and graphs). 

• Provide sufficient contrast for all text and for informational graphics such as charts. A good rule of thumb

– if you print it in gray scale, can you read it with ease? Can you distinguish any parts that are not
labeled?

• Don't use color as the only way to convey content. Label parts directly and consider using texture instead

of color, to distinguish elements.

Test your content with the gray scale test. For a more precise test, check your contrast levels with a color 
contrast checker (you are aiming to pass "WCAG AA").  

Alternative Text for Images 

Screen readers require descriptions of all graphics (photographs, charts, or other images) to be added by the 
author of the website. This description is called alternative (alt) text. When a screen reader reaches an image on 
your page, it will read out loud the description you have added. If no description has been provided, the image 

will either be ignored or the screen reader will simply read the word “image”.  

Image types that can be given alternative text include: 

• photographs
• illustrations

• images of text

When alt text is added correctly to an image, it allows a user of a screen reader to get a sense of what that 
image is and its purpose in context. 

Best Practices for Alternative Text 

Alternative text should be: 

• Accurate and equivalent—present the same content or function as the image.
• Succinct—no more than a few words are necessary; rarely a short sentence or two may be

appropriate.
• NOT be redundant—do not provide information that is in the surrounding text.
• NOT use descriptive phrases—screen reading software identifies images, so do not use phrases such as

"image of..." or "graphic of...".

How to Add Alt Text to Your Images: 

The new templates provide many content types or modules and each has a slightly different location for entering 

alt text. There should be a field labeled "alt text" or "alternate text" in any module that allows for an image. 
Please reach out if you can’t figure out where your alt text should go.  

Inline images 

1. Navigate to the page where your image is located.
2. Click on the Edit tab. Scroll to the WYSIWYG area and select your image.

http://webaim.org/resources/contrastchecker/
http://webaim.org/resources/contrastchecker/
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3. Right click and choose Edit Image. A pop up window will appear showing the Alternative Text field.
4. Enter your alt text and submit.

Figure 4: Pop-up window for editing inline image information on the CMS 

Images in other content types 

People Block 
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Feature 

Media 
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Gallery 

Figures 5-8: Alt text locations for different content types on the CMS 

For more information on using alt text, visit the Accessible Images page of our site. 

Audio & Video 

Closed Captions and Transcripts 

If you decide to include audio or video on your site, you will need closed captions, descriptive transcripts, or
both. You should contact Media & Technology Services (MTS) for assistance adding captions to your media. 
For information on how to write and add a transcript, visit our how-to guides for transcripts. 

Audio only 

Audio only files (sound, but no video) should have descriptive transcripts available.

Video 

Pre-Recorded video 

Pre-Recorded video files should have captions, preferably closed (includes a button to turn captions on and 
off) as well as a descriptive transcript.

• New Video/Video you own: MTS can work with you to set up closed captions for your video. See our
how-to guides for transcripts for advice on writing your captions or contact MTS about having captions

and transcripts written for your video.

• Videos from external sources (YouTube, etc.): you should not embed or link to videos that do not contain
captions. If you are the creator of a YouTube video, you may add captions yourself. If the video does not

belong to you and is not accessible, you should avoid linking to it directly from the Brandeis website.

https://www.brandeis.edu/communications/digital/accessibility/best-practices/alt-text.html
mailto:mediaservices@brandeis.edu
https://www.brandeis.edu/communications/digital/accessibility/how-to-guides/accessible-transcripts.pdf
mailto:mediaservices@brandeis.edu
https://www.brandeis.edu/communications/digital/accessibility/how-to-guides/accessible-transcripts.pdf
mailto:mediaservices@brandeis.edu
http://support.google.com/youtube/answer/2734796?hl=en
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*Please note: some services, for example YouTube, offer autocaptions (the computer will write the captions for
you). This is a good start, but they are neither dependable nor accurate much of the time. If you decide to use
autocaptions, please review the captions the computer provided, edit them for accuracy and add punctuation
before releasing or linking to your video.

Live streaming video 

Live streaming video should have captions, preferably closed, (includes options to turn captions on and off). It is 
generally understood that transcripts are unavailable for live video, but when possible (streaming a speech or a 
reading/performance of pre-written material), transcripts should be provided. 

MTS can help you set up streaming and live captioning service for live events. 

Other tips 

Sometimes users create "lists" by manually numbering or creating fake bullets with asterisks, etc. While this 
provides visual structure for sighted users, it does not provide the document structure needed for assistive 
technology users. Use the tools provided in the CMS editor for creating bullets and numbered lists. 

Figure 6: WYSIWYG editor toolbar 

Principles into Practice 

For more details on Web accessibility at Brandeis, please visit our site. There you will find how-to guides, a 
glossary, frequently asked questions and access to further training. 

For more help or to report a broken link in this document, please contact the 

Brandeis accessibility team (webaccessibility@brandeis.edu). 

Note: If you received this document as a paper copy, a version with active hyper-links is available at 
www.brandeis.edu/web-accessibility/how-to-guides.html

mailto:mediaservices@brandeis.edu
https://www.brandeis.edu/web-accessibility/index.html
https://www.brandeis.edu/communications/digital/accessibility/how-to-guides.html
https://www.brandeis.edu/communications/digital/accessibility/glossary.html
https://www.brandeis.edu/communications/digital/accessibility/faq.html
https://www.brandeis.edu/communications/digital/accessibility/training.html
mailto:webaccessibility@brandeis.edu
www.brandeis.edu/web-accessibility/how-to-guides.html
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